INTRODUCTION TO COMPUTER

Who s known as father of Computer?
Charles Babbage
) Alan Turing
(c) Bill Gates
(d) TIm Bermners-Lee

2 Internet mostly uses for purpose of

fertainment (b) Business
{(:])/gmail (d) Chal

3 What type of devices are CDs or DVDs?
~ (a) Output (b) Input
(c) Electric ~(d) Storage
‘4 Who created Pretty Good Privacy (PGP)?
' \(‘?3 Paul Zimmerman (b) Ken Thompson
(c) Bill Gates (d) Tim Berners

‘What kind of computer memory s both static
angnonvolatile?

(b) RAM
(d) NAM

Whe type of device is a digital.camera?

Input
(d) Mechanic

Whi h of the following is not a network

Ping (b Netclg

(d) BMW

ollowing s not an Interet

9 AL
~(d) None of these

1.

12.

13.

14.

15,

16.

17

18.

19.

(a) System file

There is a process in which an item or file is
moved into an application or environment
which is different than that native to it. What
is it called?

(a) Download (b) Transfer

¢} Import (d) Protocol

The kemel provides low-level services.
Which of the following is included in Kernel's
services?

.(a) Hardware-software interaction

(b) Memeory management

*(c) Both of them

(d) None of them

What is used in a computer to protect a
networked server from damage by those who
log in lo it?

(a) Antivirus (b) Firewall

(c) Galeway (d) Flow Control

What is called a graphical representation of a

directory or subdirectory?
(a) Directory (b) Folder
(c) Partition (d) Extension

"BAT" extension refers usually to what kind of
file?

(b) Backup file
(c) Main File (d) Auto File
What was the first ARPANET message?

(a) "Hello World" (b)"Lo"

(c) Sir (d) Done

A Cathode Ray Tube is found in what?

(a) Monitor (b) CPU

(c) Mouse (d) Keyboard
Which of the following is not ‘image file?

(a) JPEG (6) TMP
(€} TIM (d) BING
ghi,uh one is not an output device?
(8) Keyboard

(c) CPU ke

(d) Mouse




21.

22.

23.

24,

25.

Which is the fastest type of computer
memaory?

(a) Cache (b) Flash

(c) Micro (d) ROM

What is the name of the professor who
coined the name virus for self replicating
programs?

(a) Tim Berners-Lee

(b) Ken Thompson
(c) Alan Turing

~{d) Fred Cohen
The capacity of computer bus depends upon
(@) Capacity of CPU
(b) Capacity of the microprocessor

~{¢) The number of data lines it contains
(d) The system software

The interface between user and computer is

‘ta) Programming (b) Hardware

(c) Memory (d) Processing
What type of device is a computer mouse?
(a) Output (6) Input

(c) Board (d) Division

Which of the following is the section of a hard

driv

(ﬁ;ﬁﬁnn (b} room

(c) Board (d) Division
Where is the  headauarers of Moot
(b} Santa Clara, California

—h_

3.

32.

33,

: lmi Guidg
{d} None of the above

Why was the first Intel Celergn
as popular as expected?

{8)" Nolevel 2 cache

(b) Caused Excess heat

(c) Bothakhb

(d) None of the above

A computer tower is NOT: ~

———

p"}mm not

(a) ACPU o Aperiphera
(c) Botha&b {d) None of these
What does BIOS stand for?

“{g) Binary ifp and ofp system
(b} Biological internet
(c) Botha&hb
(d) None of the above

FORTRAN, a compuler programming
language is mainly used for what purpose?
(a) ..Business applications

. Scienlific Research
(c) Word Processing
(d) None of these

Compact discs, (according to the original CO
specifications) hold how many minutes of

music?
j) 74 mins

(c) Botha&b

(b) 60mins
(d) Noneof these

\Which one is an email address
offi i:[ba!@m_lmﬁ"m“
(c) hitp: filmi.com/index him

(9) Noneoftheabor®
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= a) " Interrupt Request
(b) Interrupt Request Que (b) 1BM
['5]' Botha &b (c) Hewlett-Packard
(d) None of the above (d) Apple Computers

50.  Which of the following computers was the

4. mﬂ‘?m of device is a 3 1/2 inch floppy first to'use the concept of stored programs?
drive? tal Mark | (b) ENIAC
Storage (b) Software (c) EDSAC (d) UNIVAC-I
) Bu'm a&b () None of these 51.  Whatis referred by 'path'?
42 Which Windows program do you use to (a) Specifies the location of a software
manage folders and files? (b) Specifies the location of a hardware
_ Windows Explorer . (c) Specifies the location of a web
(b) Windows Accessories (d) Specifies the location of a file
() Bohado 52 Which of the following is @ PC video file
(d) None of the above extension? :
A Computer Virus cannot be contracted by (a) MVE (o) AVi

i i 'a}' Computer Scanner (c) Botha&b (d) None of these

SRRy disiette 53 Which kind of computer memory is the first to
(c) Bothab activate when you tum on your computer?
4.  Acomputer port is used to (c) ROM (d) UPS

te) Communicate with other ~computer 54, Whatis a memory cache?
~ peripherals (a) The amount of memory your computer
b) load files from the web 1as on hand for any particular task

a&b ‘(o] A temporary memory storage device
e of the above that keeps certain data available for
2 of device is a computer keyboard? quick reference

(b) Output (c) Botha&b
(d) None of these (d) None of the above

e, .' tlwhﬁlﬂﬁlgf , 90, 't"'ﬂ'I_EI'I your, compulter speed begins to d :
| ; .{Br PlIl 600MHz _Which element of memory is likely uvurtaxar?u?;
' (c) BIOS (d) LAN
56.  Which of the dyao
s ollowing is not an operating

Dhe i os

(d) LAN
mﬂtﬁpﬁﬁfdmlsa .
(8) Input “&‘“Mrnnmmr?
- @ e,
m In mﬂwﬁﬂtl%“‘.&hm
el COnnect

Proyi on, an

(5) Amoden o\ 2€" 3d broyggy . " EMet
&ﬂ}a&h abft‘mw %&
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59,

61.

62.

‘(@) Dots per inch

The sampling rate, (how many samples per

are stored) fora chbis...?
44.1 kHz b) 48.4kHz

(c) Bothadb (d) Mone of these

Software s &

Set of instructions
(b) Collection of programs
(c) Setof information
(d) Joining of programs
\What is degauss?
(a) Creating magnetic media
b} Erasing magnetic media
(c) Botha&b
(d) None of the above

\Which of the following file extensions is not
an audio file formal? |

(a) COM (o) AIF

(c) RAM (d) CPU

The resolution of a printer is measured in

b) inches

G Bonagb (@ N of hese.

“TMP" extension refers usually to what kind
of file? ' B '
o

(b) Audiofle ©

A

jtione XDEEE

70.

M.

T

73,

4.

5.

uﬁyw;mmm —
‘ta)”Universal Serial Bus

(b) Urgent Serial Bus

(¢) Universal Serial Service

(d) Universal service Bus

Which is the oldest search engine
founded in 1993)? i
(a) Google (b) Yahoo

(c), Aliweb (d) MSN

Briish scientist Tim Bemers-Lee
founder of? =
() Google Company (b) Yahoo Wal
fc) World Wide Web  (d) Fotmal

Who s considered fo be the frst
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—_— ) :ﬁ:al'!uns for Computer Data CD (¢) ‘Yahoo! Mail
( tions for VCD and Pholo CD (d) None of these
B2 Which muntl‘)"s people used more internets? 94 GDUQEE is an Amerncan 11‘LL||ti|'|iﬂ..||:|r|'3t
(a) America (b) Japan corporation which provides internet-related
(c) India ldy” China products and services, Including Internet
g3, Name of the greal Musliim scientist who was search, cloud compuling, software qnd
considered as one of the founders of advertising technologies. Who 1§ the founding
ter father.of Google? _
E Al Khawarizmi Ya) Larry Page and Sergey Brin
(b) Zakerya (b) Sabeer Bhatia and Jack Smith
(c) Abu Sina (c) Jerry Yang and David Filo
(d) Pascal (d) None of these
‘B4 Who found the term “cyberspace™? 92 A method of transferring information (often
{a) Thomas Watson (b) .Bill Gates text message) from one compuler 10 anolher
(c) Steven Spielberg “{d) William Gibson overa network Is cgllaﬂ: _
85  Whatis the meaning of Fetch? [a) Electronic Mail (E-Mail)
' - & s (b) FAX
:&r ;;l:eve data or instructions from ©) Downloading
() A programming language  that (d) Data transfer :
influenced LISP 93 Whatis called is the coding or scrambling of
(c) Specifications for Computer Data CD information in a life. So that it can only be
(d) Specifications for VCD and Photo CD decoded and read by someone who has the
86, Who sent the first e-mail? correct cecoding key?
?Tmm?;';ﬂgﬁ {a) Encryption (b) Javaapplet
(b) Alan Turing in 1971 () Exsaa (d) Encoding
{F}. Bill Gates in 1971 84, Whatis :;al!!a-d the high-capacily optical disc
(@) TimBemers-Lee in 1971 :f‘ “3'?;“»5 ';:E FE: CD, but can store much
m_mmw (a) Digital Versatile Disc (DVD)
~(b) John Mauchly (b) Super Density disc (SD)
(c) Google Company (¢) Digital Video Disc (DVD)
(d) Robert Noyce (d) Allof these
Who ding father of Yahoo? =0, ::1]19 or whats Lara Crf?
d i e first A
S mouse Pple computer that featured a
b
:c; PE Trst female CEQ of AQL
2 mﬂgfﬂmwng Faﬂ
-{dj $ﬂuengaﬂ Lisp Quage that
rac
game ter in the Tomb Raide
%.  Inwhich ye r
. arw
(&) 1963 35 ASCIl formeg
- (c) 1983 (b) 1973
; i d
.,1 KBis equal 1 (©) 1983
© 12586  © 1000p
(d) yles

1064 Bytes
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100.

101.

102.

103.

104.

Where1s the neadquarters of Intel located?

) Santa Clara, California c
(b) Redmond, Washington

(c) Tucson, Arizona
(d) Richmond, Virginia

Which is the largest search enginé of the
intemet?

(a) Google (b) MSN

(c) Yahoo (d) Bing

Second largest search engine of the internet
is

(a) Geogle (b) MSN

() "Yahoo (d) EBing

What type of devices are computer speakers
or headphones? ”~

(a) Input (5] Output

(c) Bothad b (d) None of these
“INI" extension refers usually to what kind of
file? -

(a) Image file b) System file

(c) Botha&b (d) None of these
Where does most data go first within a
_computer memory hierarchy?

(a) RAM (o) ROM

(c) Botha&b (d) CPU

What is the

floppy?

capsciy of a standard PC

108.

110.

11.

112

113,

114,

"ML BRI parwre ==y o= s

of file?
(a) Image file
(6) Animation/movie file
(c) Bothab
(d) None of the above
Which part is the 'brain' of the computer?
(a) Keyboard (b) Mouse
¢) CPU (d) Monitor
ROM is-composed of:
Micro processors
(b) Micro Chromium
() Micro Chips
(d) None of these
Which.of the following is a universal gate?
NAND Gale (b) OR Gale
(c) NOT Gate (d) AND Gale

Whlcha!lhehﬂmﬂrg is used as a memory
device in computers? P
by Fiip Flop

(a) Rexctifier

(c) Comparator (d) Noneof these
First generafion computer systems used

(a) Transistors tb) Vacuum Tube
{c) Sliconchips  (9) None of these

drive is also called:
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c) Chromium (d) Gold 127. The computer which has incorporated the

120. The center processing unit of a computer characlers of analog and digital compulers (s

consist 3 units namely: tay” Hybrid computers
“{a) Arithmetic Logic Unit, Control Unit, (b) CRT screen
Memory Unit (c) Personal computers
(b) High level Unit, Control Unit, Memory (d) Professional compulers
Unit . light pen
198, The medium is used DY input dives I'g
(¢) Arthmetic Logic Unit. Body Unit, rmegrr;phlcal inpul 1s:
Memory Unit (a) Interpreter (b) Binary Coded
{d) f'ujﬂt_?metic Logic Unit, Control Unit, Main (¢) CRT screen (d) Flow chart
ni h
129, The transiator program that translates eac
121. Which term is used for a group of personal ine of the source program as it run is called
computers linked together in order lo share {a) Interpreter
programmes, data and peripherals? {b) Binary Coded
(a) LAAN (b} LAN (c) Decimal Interchange
(e) LAWN (d) LAON (d) Flow chart
122. LPTH is the name used by MS-DOS. What is 130. A small, silicon object which contains
meant of this term? microscopic circuitry is termed as:
(a) The first USB port on a computer {a) Processor (b) Microchip
%}’ ,,“IE_‘;‘ihail‘iLrst socket on a computer (c) Transistor (d) Chipboard
e first parallel port on a computer ] - 2
(9 Tt compoton e RS0 L il
123. :I'he_ surface of a hard disk is logically divided (b) Smaller than the Main Memory
:{“‘;‘ o (c) Slower than the Main Memory
(a) Firmware |d) Botha&b
(b) ___§j_M 132  The pictorial representation of roced
e}~ Pie-shaped seclors s ion of the procedure
| [d) Nonecfihese (a) pt:nmrp::emve SRS Pragren
124, Smallest graphic unit that can be dispiayed (b) Binary Coded
on the screen, usually a single coloured do (c) Decimal Intercha
is called: (d) Flow chart e
i (d) Al of these ‘ a[[am:dciléed a hardware item that can be
a com i
acts a5 @ bridge between two functionality, such |‘.=ut~::.-r 1o increase its
s or networks o that data can be (3) Addilional e . PINLEF O monitor?
‘between @ numbers  of (e Per h“'=“ devices (b) Accessory
Whats it? pheral A
e (b vare 134 Name the term | Doy
' 12 . which |
them Both of them connection on gn IBM P?.‘, :F:Ed for the

com ]
ugg:dl&ir“ usually named |pry compatible
Co d cable I'nrapara_ﬁel .} whEFE is
e Port gy el
n ort
- A pmgraml d] F‘arallel Pgn

wiitlen Using binary codes is

nl ki
O a compyge, is l:::g;‘ﬂ"ral isn'y
©) Exenggn | Eh]ﬂnam“
@ Fie
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Himi Guigg

136 COBOL Is stands for:

137

138

139

140,

141.

142,

Common Business Oriented Language
(o) Compiete Business Oriented Language
(c) Common Business Original Language
(d) Common Business Criented Level

Which is the biggest company of Compulers
in the world?

(a) Dell (b) HP

(6} I1BM (d) None of above
Which is the biggest company of Computer
software in the world?

(a) Google (b) Yahoo

(c) Microsoft (d) Oracle

Do you know about ALGOL, BA_&C, COBAL,
4GL, 3GL, Java, PASCAL, C,C " and VB?
{a) Computer companies

{b) - Computer websites

(c) Computer languages

(d) None of these

ROM is the acronym for:

(a) Read only Memory

(b) Read over Memory

(c) Read of Memory

(d) None of these

RAM is the acronym for:

(a) Read after Memory

(by" Random Access Memory

(c) Read all Memory

(d) None of these

What part of your computer deals Wit
PPMs? [

(a) Keyboard (b) Modem
{c)" Printer (d) Hard drive
Which of the following is  programming

146. Whatis CPU?
(a) Car Pressure Unit
(b) Qenlral Pressure Unit
foy~ Central Processor Unit
(d) None of these

147.  Modulate-Demodulate is a communications
device that enables a computer 1o transmif
infarmation over a telephone line. By what

name It is popular? -
(a) Scanner “(b) Maodem
(c) Modulator (d) None of these
148. The famous Silicon Valley is situated in which
state-of USA:
\“{a) California (b) New York
{c) Ohio (d) New Jersey
149. The first computer virus was created in the
1970s at
“{a) Bell Laboratories
(b) IBM Laboratories
(c) HP Laboratories
(d) Dell Laboratories:

150. Whatis *http" in Computer Language?
(a) Hyper Text Transfer Program

(b) _High level Text Transfer Program
Hyper Text Transfer Prolocol

_______
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156, What do we call the part of the screen you
can click on which displays a list of
.qmgmmds‘?
fa) AMenu (b) The Computer
(¢} Some Documents (d) None of these

457. What do you call the space where the
computer does its processing?
(a) CPU ) RAM
{e) 0S (d) ROM
158 A method of transferring information (often
text message) from one computer to another
OVE network is called:
a) Electronic Mail (E-Mail)
(0) FAX
(c) Downloading
(d) Data transfer
159, What is called is the coding or scrambling of
information in a life. So that it can only be
decoded and read by someone who has the
\ decoding key?

(b) - Gache memary
'(d) Disk Cache
modem which can handle FAX
also fransmit data. What this
(b) Datamodem
(d) None of them

165

166.

167.

168.

169.

170.

172

172.

| system and

een the locad
To copy files betw s

any system reachable over the n
called FTP. FTP is the acronym for:
(a) First Transfer Protocol

‘ {b) File Transfer Procedure

(c) File transfer protocol
(d) Floppy wransfer protocol

\What is meant by the term 'H

(a) Thatlinks @ PC to server

(b) Text which is used between 3
ISP

(c) Text which can be

, software . .
1] Text that links to other information

What do you mean by hardware?
(a) Hard disk
(b) _ Processor

\{€) Computer machinery
(d) Motherboard
Which of the following terms is used 1o
describe the starting point, or main page of a
web site?
(a) First page (b) Links page
(c) Initial page ‘(dy” Home page
Which computer acts as a server for other
computers on the network?
(a) Mainframe (b) Host
(¢} Main'server (d) Master

How many generations of com
. puters hav
been developed till date? ;

@ 4 s

KB, H?b%ﬂﬂs:: mmw .
;i
@) Noneofthess Bytes Giga Bytes
J:; ?,';lghﬂ bits is caleq:
@ e

n_.rpeﬂe:n:t'?
PC and

read with special



MICROSOFT WORD OFFICE

Which of the following is not valid version of
MS Office? :

(a) Office XP
(c) Office 2007 (d) None of above

You cannot close MS Word application by
(a) Choosing File menu then Exit submenu
(b) Press Alt+F4

(c) ~Click X button on title bar

(d) From File menu choose Close submenu

The'key F12 opens a
(a) Save As dialog box
(b) Open dialog box
(c} Save dialog box
(d) Close dialog box

What is the short cut key to open the Open

dialog box? 0

(a) F12 (b) _Shift F12
() Alt+F12 (d) Ctrl+F12

A feature of MS Word that saves the

document automatically after certain interval 14,

is available on

(a) Save tab on Options dialog box
(b) Save As dialog box

(c) Both of above

(d) None of above

Where can you find the horizontal split bar on

MS Word screen? 18.

(a) On the left of horizontal scroll bar

(b)On the right of horizontal scroll bar
"(€) On the top of vertical scroll bar

(d) On the bottom of vertical scroll bar

Which of the following is not avallable on the
Ruler of MS Word screen?
(a) Tab slop box (b
(c) Rightindent "¢ )

Left Indent
Center Indent

wmnsplacammaleﬁafnmmntamﬂ 2

bar?
(a) Tab stop bultons
(c) Split buttons

b) View buttons
(d) Indicators

Which file starts MS Word? 18.

(b} Office Vista 10

(i

12.

12.

17.

a) Winword.exe

(b) Worde
(c) Msword.exe >

(d) Word2003.exe

How many ways you can save a document?
(@ 3 (b) 4
& 9 \d) 6

If you want to keep track of different editions
of a document which features will you use?
(a) Editions (b) Versions

(c) Track Change (d) All of above

Background color or effects applied on a
document is not visible in

(a) Web layout view

(b) Print Layout view

(c} Reading View

“(d) Print Preview

What is a portion of a document in which you
sel certain page formatting options?

(a) Page (b) Document

(e} Section (d) Page Setup
Borders can be applied o

(a) Cells (b) Paragraph

(c) Text (d) Al of above

Which of the following is not a type of page
margin? . |
(a) Left (b) Right |
(c) Center (d) Top |

What is the default left margin in Word 2003

document? ~

(a) 1"

() 1.5

What is gutter margin?

() Margin that is add
when printing

(b) Marglnmamaddadmr@tmm

(6) 125°
(d 2

ed to the left margin
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18.

2

J3k

() Page Orientation (b) Paper Size
{c) Page Layout (d) Al of above

if you need to change the typeface of a
document, which menu will you choose?

(a) Edit (b) View
[e)/ Formal (d) Tools
Which of the following is not a font style?
{a) Bold (b) [ltalics
(c) Regular (dY" Superscript

Which of the following is graphics solution for

57
{; Clipart (b) WordArt

(c) Drop Cap (d) All of above

The keystrokes Cirl + | is used to

(a) Increase font size

(b) Inserts a line break

{c) Indicate the text should be bold
Applies italic format to selected text

A characler thal is raised and smaller above

the baseling is known as

(a) Outlined (b) Raised

(e} Superscript (d) Subscript

What s the purpose of inserting header and

footer in document?

(a) To enhance the overall appearance of
the document

(b) Tomark the starting and ending of page

(¢) To make large document more readable
(0) To allow page headers and footers

Lh

appear on document when printed

25, Which of the following function key activates

3 F‘ﬁ *{ui Shift + F7

(b) 2and1
(d) None of above

ol in MS Word is used for

18) Todrop al the capita letters
) To automatically begin each paragraph

28

31

32

35,

@) Double click the

with capital letter

()" To begin a paragraph with a large
dropped initial capital lefter

{(d) None of above

A bookmark is an item or location in

document that you identify as a name for

future reference. Which of the following task

is accomplished by using bookmarks?

(a) To add anchors in web page

(b) To mark the ending of a paragraph of
documentl o

(¢) To quickly jump o specific location in
document

(d) To add hyperlinks in webpage

A word processor would most likely be used

lo do

(a) Keep an account of money spent

(b) Do acomputer search in media center

(c) Maintain an inventory

{d) Type a biography

\What happens when you click on Insert >>

Picture >> Clip Art

(a) ! inserts a clipart picture into document

(b) It lets you choose clipart to insert into
document

{c) Itopens Clip Art taskbar

(d) Mone of above

Which option is nol available in Insert Table
Autofit behavior?

{8) Fixed Column Width

(b) AutoFit to Contents

(c) -Autofit to Window

{d) Autofitto Column

To autofit the width of column

right border of column
left tI'DFdEI' of coly mn
column header

(b) Double click the
(c) Double click the
(d) Al of above
From which men
Footer?
E:; g‘m’;‘kﬂu 'fb] View Meny
After typi e (@) Tools Meny

r I?D‘lng header text, how ‘
T e

eSS PageDown

U You can insert Heager and
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then type the fext

36.

37.

38

39.

40.

(c) Both of above
(d) None of above

When inserting Page number in footer it
appeared 1 but you wish 1o show a. How can
you do that?

(a) From format menu choose bullets and
Numbering and configure necessary
setting

(b) From Insert menu choose Page Number
and specify necessary setting

(e) Click on Page Number Format tool and
specify required setting

(d) All of above

Which of the following statement is false?

(a) You can set different header footer for
even and odd pages

(b) You can set different page number
formats for different sections

(c) You can set different header footer for
first page of a section

(d) You can set different header and footer
for last page of a section

Where can you change the vertical

alignment?

(a) Formatting lg-n’abar

(b) Paragraph dialog bc-_x

(c) Page Setup dialog box

(d) Standard toolbar e
‘Symbol’ dialog DOX, & .

To get lﬂt;fﬂ;l O ool

a Insert (b) Format

_Es] Tools (d) Tahlﬂ i
Which of the following sgmhnlﬂaﬁ;]; szﬂnbﬂl
most likely to contain & mathermate® B o
_guch as @ deg e sign, greater than 0 |

43,

44

45,

47.

i Guidg
i Wh
insertion line is. ich the

(d) None of above

How can you disable extended
mode? selechion

(a) Press F8 again to disable
(b) JPJess Del to disable

(o}’ Press Esc to disable

(d) Press Enter to disable

What does EXT indicator on status bar of M3

Word indicate?

(a) It indicates whether the extarmnal tex! is
pasted on document or not

(b) W indicates whelher extended add-ons
are installed on MS Word o not

(e) It indicates whether Extended Selection
mode is turned on or off

(d) None of above

What is the maximum number of lines you
can set foradrop cap?
(a) 3 (b) 10
fe) 19 (d) 20
What is the default number of linés to drop
for drop cap?
fa) 3 (b} 10
e) 15 (4) 20
What is the shortcut Key you can préss

‘ampﬁghtmbcgl e

Cir+C :

IE::; ?;1;+G (d) Cii+Snif+C
How many columns can you insert a word
document in maximum?
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. “ unassigned
i {b) Located on the len-key pad section of
your keyboard.
| (c) Assigned to another task.
r (d) From the same font family as the
. symbol.
| 62 you wanted lo creale an

Suppose

AutoCorrect entry that would type the words
k 'We regret to inform you that your submission
has been declined’ Of the following choices,
: which would be the best name you could

E assign to this entry?

E})r)ﬂﬂfm

i - Subdual

|[ (c) We regrel to inform you that your
4 submission has been declined

{d 1

53 If you want to convert a symbol or several
lines of text into an AutoComect entry, you

-[:F[nm the symbol or type the text in a
Word document first. Then, select the
text or symbol and go to the AutoCorrect

 dialog box.

(b) Click the Tools menu and choose
AutoCorrect Options. Then, click the
Insert menu and choose Symbol (or
click the Format menu and choose
Paragraph) to add the symbol or

 paragraph fo AuloCorrect

() AutoCorrect can only accommodate one

text. Itis not possible to convert a

or multiple lines of text into an

rrect entry.

symbol or type the text in a

document first Then, select the

“symbol and click the Edit menu

56.

57.

59.

60.

61.

62,

63,

(b) Using your mouse or keyboard, perform
the task you want 10 automate

(c] Assigna keyboard shortcut 10 the macro

(d) Give the macro a name

If you will be displaying of l:lll'ﬂll'l"fil your

document on another computer, you Il want

to make sure and select the ____ Option
under the ‘Save’ {ab.

{a) Embed Fonls

(b)” Embed True Type Fonts

(c) Save True Type Fonts

(d) Save Fonts

In Word, the mailing list is known as the:

(a) Datasheel (b) Source
{c)Data source (d) Sheet

Which of the following is not one of the three
'Mail Merge Helper' steps?

(a) Merge the two files

(b) Create the main document

(c) Setthe mailing list paramelers

(d) Creale the data source

Which of the following button will allow you to
add, delete, or change records in your Data
Source?

(a) 'Data Source' button

(b) 'Edit' button

(c) 'Edit Data Source' button

(d) ‘'Data editing’ button

It is possible to a data
before performing a merge, -
(a) Create (b) Modify
E.::_l Sort (d) all of the above

at is the default font size of a ne

w W
?:::M;:IT:: based on Normal lemplate? i
(b} 12 pt
(c) 14pt
(d) None of abg
What is the de iy
ﬁ@mnt? fault font yseq in MS Word
al Times New
E"]] ol Roman
©) Algerian
(d) Preet
Which tabin F
; tdia

12 20ply font effecys 8 box contap
@) Fontiay e
(b) cn
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\.q"' r.l'l'\l r thl:h v EB! ! t i text by one w'“t avery T}TI'FB?
() Standard 106 [l i (&) By pressing o+
g4 Il you need lo doudle underling 8 . (o) By pressing out + |
will you do that? o ressing Ctrl +}
(a) Go to Format menu and then Font ‘[: d:; g;:f@ﬂng Ctri + {
option.  Open Underiine  Style and . : S
choose Double Underiine 72, Whmhl-:-'! the following line spacing is invalid?
(b) From Format menu choose Font oplion (a) Sﬂ_‘lgia (b) thle
and then from Font tab open Underline (c) ~Triple (d) Multiple
Siyvie and salect Double Underline 73 How can you apply exactly the same
T Salect the lexl then choose Formal >> lr;rfmaﬂil'lg you did 1o another text?
Eamt and on Font lab open Underline {31] Copy the text and Pﬂﬁte in new location.
Stvle and choose Double Underline Then type the new text again.
(< Chick double undering lool on I'nrmattlng [b] Gﬂpjf the lext and click on Paste M
toolbat 100 on new place
85  DropCap means (¢] Select the text then click on Format
(a) Al Caps (b) Small Caps Painter and select the new lext
(c) Title case (d) None of above (d) Al of above
35 What is the short cul key to open Font dialog 74, What should you do if you require pasting the
box? same format in many places?
(a) Cti+F (b) Alt+Cid+F (a) Click the Format painter and go on
(c) Cu+D (d) Ctrl + Shift+D pasting in many places holding Alt Key
57 How can you access the font size tool on (6] Double click the format painter then go
formatting ' on pasting in many places
(a) Cl+ 3 (b) Gl + Shift +S (c) Cild( the format _pdntar then go on
() Ci+P WW* $|'ﬂﬂ'+ p @ mﬂﬂ to many places holding Cirl Key
§8  How can you make the sefecled character D

@ Noneofabowe

-------
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78.  Which operation you will perform if you need
o move a block of text?
{a) y and Pasle
o) Cutand Paste
(c) Paste and Delete
(d) Pasteand Cut
79.  Whatis the extension of Word filas?
(a) FiL (b) DOT
- (d) TXT
80. Which of the following option is not available
in Insert >> Picture?
{a) Chan (b) Word Art
() Cipart 4d) Graph
81, Toinsert a drop cap in one of the paragraph
you should access
(@ hsetVens ) Fomal

(d) None of above

the maximum number of fines you
for lines to drop box?

88.

89.

1.

92.

'J{a} 0

’fﬁf Both of above

(d) MNone of Above

How can you break the current column and
start a new column immediately?
-f(éf Press Ctrl + Shift + Enter

(b) Press Alt + Enter

{c) Press Cirl + Enter

(d) Press Alt + Shift + Enter

What is the smallest width of a column?

(a) 0O “b) 05

() 1" (d) 1.5

If the number of columns is selected 1 and
the line between check box is marked, where
is the line drawn?

(a) in the left margin

(b) in the right margin

(c) _beth in left and right margin

(d] None of Above

The other Col# are inactive when you've
select 3 columns. How will you activate those
boxes?

(8) double click on spacing box

(b) double click on inactive Col#

(c) Remove mark from Line between

- checkbox
{d) Remove mark from Equal Column Width

check box

How much space in minimum m
ust be
provided between columns?

) 1

H.[d] ;pﬁmum
To open Columns gig .
~mns dialog box q
(8) double glik on the iaﬂqmlfrﬂgfn area of
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(b) Office Assistant

(c) ;leipmanu :

[ﬂrmfn-mahm

s

: mtq:.upﬁpn'-m_mhm.

flmi Guid

ﬁ
@ Aulo lex! (d) Bothadec
(b) Autocorrect 103. Which is not a data source component?
(c) Auto summarize (a) mail merge loolbar (b) header row
(d) Macro {c) data fields (d) data records
95 To move the cursor page lo page of 104, Which of the following is not the part of
document standard office suite?
(a) Clri+PgDn {a) Word Processor
(b) Cirl+PgUp (b) Database
(e} Both of the above (c) Image Editor
(d) None of the above (ﬂj File manager
87 Text boundary can be displayed or hidden 105. Where canyou find the Draw Table ool
from buttan?
(a) Auto text option from Insert menu (a) Standard toolbar
(b)  Options from Teols menu (b) Formatting toolbar
(c) Customize fram Tools menu (c) Drawing toolbar
(d) Al of above {d) Tables and Formatting toolbar
98.  Which of the following are word processing 106.  Which of the following option in File pull down
Softwars? menu is used to close a MS Word document?
(a) WordPerfect (a) Quit Close
(b) Easy Word (o) Exit (d) New
(c) MS Word . P
(d)All of above 107. You need to jump lo the next
: breaking current column right at the cursor
93.  MS Office provides help in many ways, which position. How can you break column?
of these is one of them? (a) Pressing Ctri+Enter
{a) Whatis this?

m -ﬁmmg AltsShift+Enter
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411, Which of the following is not availabie in Font
Spacing?
() Normal
|u]-ffnnael:.r
(c) Condensed
(d) Expanded
112. Which of the following position is not
available for fonts on MS Werd?
(a) Normal (b) Raised
(c) Lowered (d)” Centered

113, What is the maximum scale percenlage
avallable in Scale drop down box?

() 500 (6] 200
(e) 100 (d) 80
114, Bold, ltalic, Regular are known as
(a) font styles {b) fonteffects
(c) word art {d) texteffects

115. You can refresh the Page by

 (a) PressShift+F7 (b) PressCti+F7
c) Press Alt+ F7 (d) Press F5

118. You can Open a New Bmwsar Window by
Press.
(a) Shift+ F7 (6} m +N

(o) AFT (d) F7
117 Youean Refresh Current Window by Press
- Cir+R (b) Ctri+W
{ Ciri+H (d) Ciri+LO
pum Close the Active Window by Press
f2) CieR (B) Ciri+w
) Clri+H (d) Cii+LIO
'-Qﬁns the History Window by Press
(o) Ctri+w

{d] CWUD

122,

123.

124,

125.

126.

127.

128,

129,

130.

131.

permanent but All Caps on Font can
always be reverted

(d) All Caps on Fonl dialog box makes the
change permanent where Change Case
can be always reverted

If you need fo hide some paragraphs, how

can you do it?

(a) From Paragraph dialog box

(byFrom Font dialog box

(c) From Options Dialog box

(d) None of above

Which of the following is the latest version of
MS Word?

(a) WWord 2000 (b) Word 2007

(e) Word 2010 (d) Word 2011

Changing the appearance of a document 15
called

(a) Proofing (b} Editing

{c)” Formatting (d) All of above

In a document what is the maximum number
of columns that can be inserted in MS Word
Table?

(a) 35 (6) 15

fe) 83 (d) 65

You can detect spelling and grammar errors

by

(a) PressShift+F7 (b) Press Ctrl +F7

{G:I Press Alt+ F7 Ld]-"ﬁreﬁ =
You can paste the text by Press

S (b) ChisC
)X (@) Ciri+v

You can Undo Command i ;
by Press in word Microsoft

(a) Ctri+A Sl

6 Gx g gy

You can cut the se

(a) Cti+a m{{;“? Press
(&) Ctri+x ) Cﬂtg

EH ?mey ® selected Text by Press
(¢) Ctriex ﬁ; Eﬂ*ﬁ
You +
Prase 2" Select Al (Enge Documen)
(@ Cirisp by
(c) Ctrisx (b) Ciisc




MICROSOFT POWERPOINT

Which file format can be added to a

PowerPoint show? g
a) Jpg GV
Erj wav (@1 All of these

2 In Microsoft PowerPoint two kind of sound
gffects files that can be added to the
tation are
' (ar” wav files and mid files
(b) .wav files and .gif files
(c) .wav files and jpg files
(d) .jpg files and .gif files
3 Matenal consisting of text and numbers is

best ted as
m slide
(c) Atitle slide
4 Whatis a motion path?
(a) Atype of animation entrance effect
(b) Amethed of advancing slides
A method of moving items on a slide
~ (d) Allofthe above
8 Whatis a slide-title master pair?
{s%]de The litle area and text area of a specific
(b} a slide master and title master merged
;Etp}aimle slide
A m master and title master for a
Specific design template
::.I@'f M'Df above i
Which of the following should you use if you
Want all the slide in the presentation to have
b
slide layout
T 3 presentation design template
.o conlext of animations, what is a

(b) A bullet slide
(d}) All of the above

oint show you created
sing email to another
the show 10 your emajl

10.

1.

12.

13.

14.

15.

(a) Inclusion Mach ment

(c) Reply (d) Forward
In order to edit a chart, you can
(a) Triple click the chart object
(b) Click and drag the chart qtuect

Double click the chart object
(d) Click the chart object
to exit the PowerPoint
(a) click the application minimize button
(b) glick the document close button

double click the applications control
menu icon
(d) double click the document control menu
icon
To preview a motion path effect using the
custom animation task pane, you should
()" click the play button
(b) click the show effect button
(c) double click the motion path
(d) all of above
You can create a new presentation by
completing all of the following except
(a) Clicking the new butten on the standard
toolbar
(b) Clicking file, new

licking file open
5;:1,‘- Pressing clrl + N
ou can embed o .

a slide by a MS-Organization Chart in

(a) Clickin i _
menu 9 the object command on the edit

(Clicking

the obi
Menu object command on the et

(c) Clicking the ins
e
standard toolbar.

[3? = tton on the formatting
Clicking  the
S- 25t
Uton on the standarg ug;'biﬂmzatron Chart
rli

9 cul S
e
al effects of 3
Preseniaf; us i
E presec:.ln dre called “’Dduce Elidas in
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16.

17.

18.

19,

21.

I1mi Gyigg
What is the term used when you press and (a) Vertical T L2 —

hold the left mouse key and more the mouse

around the slide?
(a) Highlighting [h‘)/aragging
(d) Moving

(c) Selecting

Which of the following toclbars provide

diffegant options in various master views?
Common tasks toolbar

(b) Drawing toolbar

(c) Formatting toolbar

(d) Standard toolbar

How can you creale a uniform appearance by

adding a background image lo all slides?

(a) Create atemplate

(b}—Edit the slide master

(c) Use the autocorrect wizard

(d) Allof the above

Which option on the custom animation task

pane allows you lo apply a presel or custom

motioa-path?
Add effect (b) Emphasis
(c) Animate now (d) Allof the above

What is the term used when a clip art image

changes the direction of faces?
(@) p (b) Flip
Rotate (d) Allof the above

The slide that is used to introduce a topic and

sel the tone for the presentation is called the
(a) table slide {%m side

(c) bulletsiide title slide
Which of the following features should you
use when typing in the notes text box?

(a) Sideshow  (b) Jnser
Which allows you to
frefor ble tools?

I

e

21.

28,

29,

31

0 Potatl (g T

anl a rPoint photo a

to Unuuuslﬂpm UM Site shoy
Use random slide transitions

(b) Launch an online broadcast

(c) Loop continuously

(d) Allof the above

What is defined by the handout masjer?

E}(Slide formatting
Layout of audience handout notes
(c) Handout content formatting for Micrasqh

word export

(d) All of above
Which of the following tool enables you fo
add text to a slide without using the standard
pﬁmﬁulﬂers?

a) Text tool box
(c) Drawing tool
tocl

(b) Line tool
(d) Auto shapes

In notes master view, how do you modfy the
font size of text for all hied notes of a
presentation?
(a) Modify the slide design
(b) ify the notes master layout

Modify the text within the body
placeholder
(d) Allof the above il
Want your logo in the same position on every

slide, automatically? Insert it on the
{a)
(

" Handoutmaster  (b) Notes master
“Siide master  (d) Allofthe above
Which of the following views is the best view
when setting transition effects for &
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== master view bulton
c) Onthe view menu, click slide sorter. and
glick handouts
d) Allof above
57, How can you quickly reinstale a deleted
~ {ooter placeholder in master view?
3) Creale a new slide master
m’ﬁ Re-apply the footer placeholder
(c) Re-apply the slide layout
- (d) Allof the above
o 23 Which of the following can you use to add
fimes fo the slides in a presentation?
(a) Slide show menu
{7 Rehearse timings button
(c) Shide transition bution
(d) Adlof the above
40 Toselect all of the boxes of an organization
- thart
(a) Clicking and edit and select all
(b) Right click the chart background and
then click select all
{c) Press and hold the SHIFT key and click
gach box
(g3 All of above
40 You can show the shortcul menu during the
siide show by
{8) Cicking the shorfcut button on the
atting foolbar
Right clicking the current slide
-i@] Clicking an icon on the current slide
~ [d) aandb
Aulo clipart s a feature that
[2) Automatically places clipart in your

18) Seans your presentation for incorrect
. 3eiin | In your words on each slide

) Scans your presentation for incorrect
 Speling in Word Arts objects

above

e text within the boxes of an

The vigy, o o3ch siide
et displays the sfides on

46

47

48

49.

51.

52.

presentation as miniature representations of

the slides is called

4(?]'; slide sorter view  (b) slide show

(c} noles page view (d) outline view
The PowerPoint view that displays only texi
(tille and bullets) is

(a) Slide sorter view (b) _Slide show

{c) Notes page view (d]" Outline view

In Microsoft PowerPoint the entry effect as
one slide replaces another in a show is called

a (an) 3
(a} animation {by” slide transition
(¢) custom animation (d) presel
animabion

Which of the following presentation elements
can you modify using the slide master?

(a) Slide comments

(b—Slide transitions

(c) Speaker note font and color

(d) Al of above ,
Which of the following provides a printed
copy of your presentation?

() Outhne (b) Speaker notes

( udience handouts (d) All of the above
Slide show options available to the presenter
include-all of the following except

(8] Transitions command

{b) Speaker notes command

(c) Meeting reminder command

{d) MNawigation commands

Presentation designs regulate the formatting
and layout for the slide and are commanly
called

(a) Design plates Templ

(¢) Placeholders Ed} Bluegr?;f:
Which of the following bypasses the print
dialog box when printing individual slides o
an entire presentation? |
a) File, pri i ;

& A i [gr?:r? okl
To add a header or footer to :

[omdaly Your handout,
(@) Title master (b) sli
) Slide maste
andout master (d) Al ufah_nvﬂr

Which of the following wi
ks n
slides in a slide shoy aeﬁ not advance the

() The (b) The space
ﬁ“ﬁf’ﬂmm e Ente @
a) Emphas; » and seri
animalgg 1 al can b gpricoe”
(BT Types of o
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36.

59.

Comments on a presentation can record who
wrote them and when they were added
What's the automatic way in PowerPoint
20027
{a) e online collaboration

Use comments
() Use the notes page
(d) Al of the above
When using PowerPoinl, lo play @
PowerPoint show for previewing the show,
select
(a) w, slide sorter  (b) View, slide
{nq)\.ﬂzw.slmﬂ show (d) View outline
in Microsoft PowerPoint in order to see all the
slides on one screen use
(a7 view, slide sorter (b} view, slide
(c) view, master (d) wiew, slide
show
What's the best place o find animated
images for your PowerPoint 2002
presentation?
(a) Microsoft onling
(67" Word clipart
(c) PowerPoint tools and ins
(d) All of the above
You can create a new presentalion by
completing all of the following except:
(a) Clicking the new button on the standard
toolbar

Wlmg,ﬁh;_nw
Clicking file open

e appears suUrrsundain he
....................

64

66.

67.

(¢c) Three slides per page

(d) Two slides per page

The selected design template can be applied
(a) To current slide only

(b) Toall the slides

(c) -all the new presentation you oreale

(d” All of above

In which menu can you find features fie
Slide Design, Slide Layout e

(a) Insert Menu Format Meny
(c) Tools Menu (d) Slde Shoy
Menu

Which menu provides you oplions ke
Animation Scheme, custom Animation, Skde
Transition?

(a) | Menu (b) Format Menu

(o Slide Show Menu (d) Tools Menu
How many sleps are there between Start and
Finish,in AutoContent Wizard?

(a) 3 (b) 4

c) 5 (d) 6

Which of the following is not a part of Slide
Design?

(a) Design Template (b) Scheme
(c) Animation Scheme ( ide Layout

What is the best way to creale another copy
of a slide? __
(a) Click the slide then press Clri+A and

agle-in new slide
ﬁ'l From Insert Menu choose Duplicate

(e Redo eveyting ona new kel s

h
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X ==Tich of the following should e used when
1. Jou want to add a slide to an existing
i tation?
{a) File, add anew slide toflnsert, new
?f]“m_ open  (d) File, new
% Which of the following is the default page
¥ selup orentation for notes pages, oullines
’ and handouts?
(a) Vertica (b) Landscape
v .H/Wl (d) None of above

77, Which of the following is Ihe default page
sehup orientation for slides ip-PowerPoint?
(a) Vertical ) Landscape
(¢) Portrait {d) None of above
78 How can you get your pholo album slide
- show lo play conlinuously?
(a) Use random slide transition
(b) Launchan online broadcast
(e Toop continuously
d) All of above
What are symbols used 1o identify items in a
ist?
e (b) Markers
1™ Bullels (d) Graphics
What lets you to create new presentation by
selecting ready-made font color and graphics

4,
i

. resentation TBFI'IF‘B{B [h}MEﬂTﬂf Slide
Design Template (d) Animation

command will you use in PowerPoint if
need to change the color of different
out changing con

gn Template r Scheme

oint feature will you use to

effects fo different objects of &
Objects Animation

2 wil you use to apply motion

1 a slide exits and another

85.

86.

87

89.

91

83,

(d] Audience handout

Which command brings you to the first slide

Iln :I‘,l’ﬂ:;‘ presentation?

4] MNextslde button (b) Pageu

(e¥ " Cirl + home (d) E1r? + Eﬁd

Objecis on the slide that hold text are called
Placeholders (b) Object holders

(c) Autolayout (d) Textholders
Good design determines
(a) Credibility (b) Readability

{c) Firstimpression  (dy~Allof above
The view that displays the slides of a
presentation as miniature representations of
the slides is called .

(a) Slide show Hﬂ’&iﬂa sorter
view

() Notes page view (d) Outling view
The power point view that displays only text

(title and bullets) is:
(a) Slide show (b} Slide sorler

view

(c) Noles page view {41/ Cutline view
Which of the following provides a printed
copy of your presentation?

(a) tines (b) Speaker notes
Audience handouls (d) All of above
Presentation designs regulate the formatting
and layout for the slide and are commonly

called
(a) Designtemplates (b7 Templates
(c) Placeholders (d) Blueprints
Line spacing refers to

The space between the lines of text
(b) The height of the line
(c) The length of the line
(d) aande

Which of the following bypasses the print

dlﬂDg box when rintin i i

an entire prmmﬂm? 9 ”di‘-rld.ual slides or

(a) File, Print Preview (6] Th

)t " g LR
andout master contai

for all of the following &mpi:ins placeholders

(a) Slide number :

O P e
you add ;

shapes Such o degrees of tran

e tougho T (e side
Use the Set T
e Picte oo ™! CO0 bt
me;& e Tm"“i'ﬂ'i'-‘il’al'll.’;yr slide
Mﬁ%diﬂk}gb@! NET in !hﬂ:

drawmg
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(e Ungrouping - _'IEJ- Grouping

All of above : 102. The auto shapes tool provides you with

96. ﬁjmmml consisting of text and numbers 1S (a) Eancy text to place on your slide

bes nled as lide Commonly found shapes
Atableside (b) Abullets (c) Any shape you want to add on a siie
(c) Alitie slide (d) Allofabove (d) Clp art thal is related 1o

g7, Wrich command seect allobject at o EPZ presentation el
(s Edil, SelectAll  (b) Alt+a 7 ‘:f;fmtg 2 SHERt Mty
(c) Cl+a (d), Snift# Enlef IBEBFl add a new slide ﬂ&}f

88 You can edit an embedded organization chart fjée ket li B
object by d) File,n

Clicking the edit object (). Fire, opan (d); Fite, new
EE; néunlﬁg ciickunlg the organization chart 104. An organizalion has a presidenl, vics
object president, managers and supervisors. On
(c) Right clicking the chart object, then what level of an organization chart are the
clicki it MS-Organization Chart object vice presidents _
(dy Bandc (a) Fourthlevel  (b) Thirdlevel

09, What is the name of the form used to input Second level (d) Firstlevel

~a values? 105. Which of the following includes special
> {4) Datasheet (b) Microsoft Excel effects that can be applied lo drawing
(c) Microsaftgraph  (d) Auto form objects?

100. Which of the following you must first (a) Gradient fills (b) Rotating
complete in order fo delete an object? (c) Line color and style (dj™ All of above
'I:;,Uﬂuﬂﬂ click the image 106. What is the term used when a clip art image
Eﬂ} S”""H Thilm %mga&;l _ll'ua.':ﬂracﬁmit-fa_gas?

TN Sl s e ©) Rotale E 2

~ s the ed to described the 107. What is the term used when you press and
bt 0 btk e 8 Poroa 10 th et mouse ey and movete mose
object? a PowerPoint ??ummgs?e? : =
(@ Enteddng (o) Regrovpin ©) Solctng =

I1..d [2 & [3 & |4 c I[85 TmEﬁmu T..b. |8 b |9 e b ‘;j

dl.a |12 ¢ [13.b |14 a |15 d |16 b 7. b T8 b J9 ¢ [10.c |(§
6 |32 a |3 a 38 ¢ 2.d |26 b [27. a |28 b |2 a [3H0.¢ |

42 a ﬂ: rre 'F._ 35— S ;.ﬁ;, b [37.b [38 b [39.d | ] TRt
e Toy o teka I8 d (465 [4r.b [4c [49a |
e 5 E_-ﬁﬁ-;_-_-_h‘__ 56. c |57.a |5 b |59
-_. nl:r _I.. 'v.-'._ .TI 3 l.l :_ | I E_ ‘ ;: I. = ——
b :Lu d [75. b 6 & - i
|8 d |85 ¢ |8 =
] 1056 1055~
= m=
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MICROSOFT EXCEL (MS EXCEL)

4 What term describes a background that
'\‘ appears s grainy, non smooth surface?

(a) Gradient (b) Pattern
(c) Solid (d) Texture
Excelis a

(a) Graphic program  (b) Word

processor
\a{c] Aspreadsheet  (d) None of these
3 Tocreale an interactive Pivol Table for the
web, you use a Microsoft Office Web

] component called
| () HTML
) Pivol Table Field List
(c) Pivot Table List
\/td] Pivot Table Report
4  What function dispiays row dala in a column
or column data in a row?
(a) Hyperiink (b) Index
\v(e) Transpose (d) Rows
5  When you insert an Excel file into a Word
document, the dala are

\v{:} Hyperfinked
v[b) Placed in a word table
)

6 Exceptforthe ... function, a formula with a
_ logical function shows the word “TRUE' or

(b) AND
"o (d) NOT
5 are ‘run” or executed from the .....

(b) Format

~ (d) Data
consoldate dialog box by

date from the

11111

\’[c} Bar charts, line graphs and pie charts

(d) Bar charts and line graphs only

11, What is the short cut key to replace a data
with another in sheet? y
(a) Ciri+R (b) Ctrl + Shift + R
(c) Ctl+H (d) Ctl+F

12, Which of the following is not a valid Zoom
percentage in Excel?

(ay 10 (b) 100
() 300 (0 500
The spelling tool is placed on toolbar

13 :
N/(a) Standard (b) Formatting
{c) Drawing (d) Reviewing
14, When a row of data is to be converted into
columns
(a) Copy the cells in row, select the same
number of cells in row and pasle
(b) Copyv the cells in column then choose
Edit >> Paste Special, then click Transpose
and OK
(c) Copy the cells then go to Format >>
Cells then on Alignment tab click Transpose
check box and click OK
\,{d] Select the cells then place the cell
pointer cn new cell and choose Edit >> Paste
gﬂﬂdﬂl- mark Transpose check box and click

15.  Ctr + D shortcul key in Excel will
E:::: E:;n gl':]funt dialog box
y double underline for the acti
\/(¢) Fill down in the selection N
(d) None of above

16.  MS Excel provides the 2
in Fill Series cialog by default value for step

(@ 0 b) 1
() § @ 10
17. The short cut key Ctr +

_ Risusedin E
. xcel to
Eh} m align the content of cel| ;
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(b) From Format Cells dialog box select the
Centered alignment
(c) From Format Cells dialog box choose
Merge and Center check box
< \v[d} Click on Merge and Center tool on
formatting toolbar
19, Tab scroll buttons are place on Excel screen
\ (a) towards the bottom right corner
(b) towards the bottom left comer
{c) towards the lop right comer
(d) towards the top left coner
20, The Name box on fo the left of formula bar
*(a) shows the name of workbook currently
working on
(b) shows the name of worksheet currently

\V‘HDIHI'I'Q on

(c) shows the name of cell or range
currently working on
(d) Mone of above

21... The default font size in Excel warksheet is

v(a) 10 points

(b) 12 points
(c) 14 points (d) None of above
22._ The default font used in Excel is
V) Arial
b)
(c) Times New Roman
(d) Preeti
23, Which of the following is not an option in the
'*&Gﬁpﬂﬁnﬁ-ﬁmﬂbﬂﬂ &
(a) Edit (b) Ignore
(c) lgnoreall ~  (d) Change
24, You can quickly change the 3

" Jour work by choosing Auto Format from th

29\’ Which symbol must all formula begin with?

30.

3.

32

33.

35.

(b) +

(a) =

(e) 9 e

Which of the following formulas is not entereq
correctly?

(a) =10+50

\"Ebl =8781
(c) =BT+14 d) 10+50
A typical worksheel has ... Number of

columns
(a) 128 \I[b} 256
(c) 512 (d) 1024

How many characters can be typed in 2
single cell in Excel?
(a) 256 (o) 1024
(c) 32,000 d) 65,535
A worksheet can have a maximum of .,
Number of rows
(a) 256
(c) 32,000 (d) 55-535@.:"5{.'_(6
Which of the following is not an exampe of 2
value?
(a) 350
(b) May 10,2001
(c) 57%
(d) Serial Number 50771
The chart wizard term dala series refefs o
(a) Achartlegend
\s(b) A collection of chart data markers
(c) Asetofvalues you plot in a chart
(d) Adatala

3. The Chart wizard term data categories refers

T
(a) Achartplotarea
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== Each excel fiie s a workbook that contains
40 ferent. sheels. Which of the following
cannot be a sheet in workbook?
(a) work sheel \'I:b]' chart sheet
(o) module sheel (d) data sheet
H Which of the following is not the correct
" method of editing the cell content?
@) Press the Alt key
) Press the F2 key
() Click the formula bar
(d) Double click the cell
42 You can merge the main document with data
. source in Excel In mail merge operation,

Word Is usually
(b) source

N, [a) server

x,[u} client (d) none

3. How can you update the values of formula
cells if Auto Calculate mode of Excel is

disabled?

() F8 \{bl Fo

(e} F10 {d) F11

44, Where can you change automatic or manual

- calculation mode in Excel?

\_ (8) Double CAL indicator on slatus bar
N(b) Go to Tools >> Options >> Calculation

~ and mark the corresponding radio button

Bath of above

i
B,

(0

1 you show or hide the gridlines in
1o Tools »> Options >> View tab and
] remove the check box named

‘when you press Ctrl + X after
me cells in Excel?
cell content of selected cells
1fom cell and stored in clipboard
©IS selecled are marked for

(c) Both of above
(d) None of above
45, Which of the cell pointer indicates you that
you can make selection?
(a) Doctor's symbol (Big Plus)
(b) small thin plus icon .
(c) Mouse Pointer with anchor at the tip
{d) MNone of above _
50.  Which of the cell pointer indicates that you
can fill series?
(a) Doctor's symbol (Big Plus)
(b) small thin plus icon
(c) Mouse Pointer with anchor at the tip
{d) None of above
51.  Which of the cell pointer indicate that you can
move the content to other cell?
(a) Doctor's symbal (Big Plus)
b all thin plus icon
EHEUSE Pointer with anchor al the lip
(d) MNone of above
52 You can auto fit the width of column by
(a) Double clicking on the column name on
column header
(b) Double click on the cell pointer in
worksheet
(c--"Touble clicking on column right border
on column header
(d) Double clicking on the column left
border of column header

53.  The command Edit >> Fill Across Worksheet
- Is active only when

{g;-/;‘rnﬂ sheet is selected
(B When many sheets are selected
[c) When no sheet is selected
& %11 None of abave
- Which of the following  you can
selectively using Paste Special mmmang??ste

(8) Validation
(c) Formulas ¥ Aﬁr;?aatgova
Paste Special allows Some operation while

YOU paste lo new cell. Which of the following

?;?arastqim Is valid?

a) Square | '

(¢) Goal Sl:gk Mda By
~ UClele commang

Eg) Deletes the content of 3 el

6. Edit>> D
) Deletes Format o o

[H’W tes the com
" Deletes sefa Nt OF cell
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58.

29,

61.

d) Data>> Delete
!I'IL Delete key of keyboard IS assigned (o

which command in Excel?
Edit >> Clear >> Contents

(b) Edit>> Clear >= All
(c) Edit>> Delete
(d) All of above :
If you need 1o remave only the formatting
done in a range (numbers and formula typed
there should not be removed), you must

From Edit menu choose Clear and then
Formats
(b) From Edit menu choose Delete
(c) Click on Remove Formatting tool on
Standard Toolbar
(d) Double click the Format Painter and
then press Esc key in keyboard
By default Excel provides 3 worksheels. You
need only two of them, how will you delete
the, third one?
3) Right click on Sheel Tab of third sheet
and choose Delete from the context menu
(b) Click on Sheet 3 and from Edit menu
choose Delete
(c) Both of above
(d) None of above
Formatting a cell in Currency, you can
specify
(o, urorcy SR Decimal Places
(eI Both of above (d) None of above
Formatting a cell in Number format you can't

67.

70.

to apply or not in AutoFormal dialog be;
(@) Number format  (b) mmm
nalh‘!(': : applied in
(a) Choose None on Border lab
e tab of Forma
(b) Open the list on Border oo
Egrmaﬂirll;l toolbar then choose first tool (no

r

Both of above

(d) None of above
Where can you set the shedding color for 3
range of cells in Excel?
(a) Choose required color form Pattems tab
of Formal Cells dialog box '

) Choose required color on Fill Color tool
in Formatting toolbar
(c) Choose required color on Fill Color fool
inBrawing toolbar
d) Al of above
You can set Page Border in Excel from
(a) From Border tab in Format Cells dialog

box
(b) From Border tool in Formatting tooibar

(c)_Erom Line Style tool in Drawing toolbar

“You cannot set page border in Excel
You can check the conditions agains!

alu (b) Formula

—_—

(d) None of above
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- (o 08 (d) None of above

75 You can sel Excel in Automatic or Manual

9 Cajculation mode. If it is in manual mode
which key you will press to update the

formuta values?

j Fa (b) FS

(c) F8 (@) F1

By default the cell pointer moves down when

you press Enter From where can you

change this setting?

(a) Tools>> Options >> View tab

(b) Tools>> Options >> Calculation tab

H"\Tmts >> Options >> Edit tab

(d) Tools >> Options >> Transition tab

71, When you start typing the same value as of
cells on same column, Excel

automatically shows that text. This feature is

known as

_butoFill (b} AutoCorrect

~ AutoComplete (d) AutoFormat

How many recent files you can display on

File menu at maximum?

e (d) 12

T 5 J%;ﬂ!fﬂl

SR

86

B7.

89.

90.

81.

92,

93.

=
(& Refresh Data (d) Show Detail
Whal is an expression that tells how the
numbers in @ determined set of cells are 10

be lated? _
(afwliccl:mula (b) Field
(c) Data (d) Query
“Ctr 1, Qtr 2, Qtr 3" is an example of 2
(a) Formula (p) Funchion
(ey Series (d) Syniax

You can edit existing Excel data by pressing

the
(a) F1key 1{;2 key

(c) F3key (d) F4key

The cell reference for a range of cells that
starls in cell B1 and goes over 10 column G
and down to row 1011s ...

(a) G1-G10 (b) G10

(c) B1,G10 ( 1:G10

What feature enables you to adjust or back
solve the value in a cell to reach 2 desired
outcome in a formula?

(a) Goal Seek

(b) Scenario Summary report

(c) Forecasting

(¢ Trend line

How are data organized in a spreadsheet?
(a) Lines and spaces

(b) Layers and planes

(s Rows and columns

(d) Height and width

" What does the VLOOKUP function do?

Eg; t%u&ﬁ:p text that contain 'v'
whether text is the same in
cell as-m the next e

Finds related records

EE.']h Tﬂu of above

at term refers to i
saved with the mmhguigmﬁc sel of values
ﬂ $anga (6) Scenario
c rend :
il () Whatif
#asy to understand nmn:lfaumm“t ina
(a) auto f(?fmatﬁng (b)
© changingonts (gl of g e
Theatocaloat feare. © 0"
] 'me:mmmm“ﬂrangeﬁf
of an mmnuﬁ: Quick way to view m:elh

2005 9 10 3 workspqy © ™UES and
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